
Thank you very much for purchasing this product.

➢ To ensure correct and safe usage with a full understanding of this product's performance, please be
sure to read through this manual completely and store it in a safe location.

➢ Unauthorized copying or transferral, in whole or in part, of this manual is prohibited.
➢ The contents of this operation manual and the specifications of this product are subject to change

without notice.
➢ The operation manual and the product have been prepared and tested as much as possible.  If you

find any misprint or error, please inform us.
➢ Roland DG Corp. assumes no responsibility for any direct or indirect loss or damage which may

occur through use of this product, regardless of any failure to perform on the part of this product.
➢ Roland DG Corp. assumes no responsibility for any direct or indirect loss or damage which may

occur with respect to any article made using this product.

Roland Software Package (RSP-009)

SOFTWARE GUIDE



Please read this agreement before opening the sealed disk package

Opening the sealed disk package implies your acceptance of the terms and conditions of this agreement.

Roland License Agreement

Roland DG Corporation ("Roland") grants you a non-assignable and non-exclusive right to use the COMPUTER
PROGRAMS in the disk package ("Software") under this agreement with the following terms and conditions.

1. Coming into Force
This agreement comes into force when you purchase and open the sealed disk package. The effective date of this
agreement is the date when you open the sealed disk package.

2. Property
Copyright and property of this Software, logo, name, manual and all literature for this Software belong to Roland
and its licenser. The followings are prohibited:
Unauthorized copying the Software or any of its support file, program module or literature.
Reverse engineering, disassembling, decompiling or any other attempt to discover the source code of the Soft-
ware.

3. Bounds of License
Roland does not grant you to sub-license, rent, assign or transfer the right granted under this agreement nor the
Software itself (including the accompanying items) to any third party.
You may not provide use of the Software through time-sharing service and/or network system to any third party
who is not individually licensed to use this Software.
You may use the Software by one person with using a single computer in which the Software is installed.

4. Reproduction
You may make one copy of the Software only for back-up purpose. The property of the copied Software belongs
to Roland.
You may install the Software into the hard disk of a single computer.

5. Cancellation
Roland retains the right to terminate this agreement without notice immediately when any of followings occurs:
When you violate any article of this agreement.
When you make any serious breach of faith regarding this agreement.

6. Limitations on Liability
Roland may change the specifications of this Software or its material without notice.
Roland shall not be liable for any damage that may caused by the use of the Software or by exercise of the right
licensed by this agreement.

7. Governing Law
This agreement is governed by the laws of Japan, and the parties shall submit to the exclusive jurisdiction of the
Japanese Court.
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1. System Requirements

System Requirements for Installing the Software

System Requirements for USB Connection

• The ability to make a USB connection depends on the specifications of the computer. To determine whether the
computer you're using is capable of correct USB operation, check with the manufacturer of the computer.

• Use a shielded USB cable having a length of 3 meters or less. Do not use a USB hub or the like.

Operating system

Computer

Drive

Monitor

Memory (RAM)

Free hard-disk space
required for installation

Interface

Windows 98 SE (Second Edition)/Me/2000/XP

Computer running Windows (Pentium processor or better recommended)

CD-ROM drive

Windows-compatible monitor capable of displaying 256 colors or more

32 MB or more recommended

30 MB

USB port

Operating system

Computer

Windows 98 SE (Second Edition)/Me/2000/XP  (Windows 95 and Windows NT4.0 are not
supported.)

1) Computers preinstalled with Windows 98 SE/Me/2000/XP at the time of purchase
(This includes such computers later upgraded to Windows Me/2000/XP.)

2) Computers on which USB operation is assured by the manufacturer of computers
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2. Installing and Setting Up to the Software

Software on This CD-ROM

: Be sure to install and set up.

: Install and set up as required.

This is a Windows-based driver required for sending data from a computer to the
machine. Be sure to install it when you are using any of the programs just described.

This is a dedicated program for controlling the modeling machine. You operate the
modeling machine and make various settings using this program.

This program is for flat engraving of nameplates and the like. It can use any TrueType
fonts registered with Windows. It also comes with its own stroke fonts. You can even
import images and engrave items such as logos. There is even a feature that lets you
import data from a list of names and engrave nameplates one after another.

This program is for designing and engraving reliefs (raised engravings). This lets you
easily add thickness to text, shapes, and imported images, and create three-dimen-
sional reliefs.

This program is for performing simulations before you actually carry out cutting using
3D Engrave. It lets you verify the finished results for shapes, the time required for
cutting, and other factors. This can help reduce loss in terms of material and time.

Windows driver

VPanel

Dr.Engrave

3D Engrave

Virtual MODELA

Information on how to use the included software is found in online help for each program.

� See "3. Documentation for the Programs."

Modeling-machine Command Modes

The following programs are compatible with RML-1. To use these programs, set the modeling machine's command
mode to "RML-1."

• Dr. Engrave
• 3D Engrave
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2. Installing and Setting Up to the Software

Windows XP

Installing the Windows Driver

1 Before you start installation and setup, make
sure the USB cable is NOT connected.

2 Log on to Windows as “Administrators.”

3 Insert the Roland Software Package CD-ROM
into the CD-ROM drive.
The setup menu appears automatically.

4 Turn on the modeling machine.

5 Connect the machine using a USB cable.
The [Found New Hardware Wizard] appears.

USB connector

Computer

USB cable

Keep the printer and the computer unconnected until you carry out this installation operation. Failure to follow the
correct procedure may make installation impossible.

� See "4. What to Do If...."
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2. Installing and Setting Up to the Software

6 Choose [Install the software automatically (Rec-
ommended)], then click [Next].
Installation of the USB driver starts automatically.

7 When the screen appears, click [Continue Any-
way].

8 Click [Finish].
This completes the installation.
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2. Installing and Setting Up to the Software

Installing the Software

1 Appear the setup menu of the Roland Software
Package.

2 Select the model name you are using.

Clear the [Windows Driver] check box, then click
[Install].
If you do not want to install a particular program, than
before you click [Install], clear the corresponding check
box.

3 The setup program starts. Follow the messages
to carry out setup and finish setting up the pro-
gram.
When the setup for one program finishes, the setup for
the next program starts. In the interval unit the next setup
starts, a dialog box showing the progress of processing is
displayed.

4 When all installation finishes, the screen shown
at right appears. Click [Close].

5 After returning to the menu screen for installa-
tion, click  .

6 Remove the CD-ROM from the CD-ROM drive.

XXX
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2. Installing and Setting Up to the Software

Windows 98 SE/Me/2000

1 Before you start installation and setup, make
sure the USB cable is NOT connected.

2 Log on to Windows. If you are installing under
Windows 2000, log on as “Administrators” right.

3 Insert the Roland Software Package CD-ROM
into the CD-ROM drive.
The setup menu appears automatically.

4 Choose the model name you are using, then
click [Install].
If there are programs you don't want to install, then clear
their check boxes before you click [Install].

5 The setup program starts. Follow the messages
to carry out setup and finish setting up the pro-
gram.
When the setup for one program finishes, the setup for
the next program starts. In the interval until the next setup
starts, a dialog box showing the progress of processing is
displayed.

6 Next, install the driver.

Select [Install]. From [Port] box, select [USB],
then click [Start].
Installation of the driver starts.

Keep the printer and the computer unconnected until you carry out this installation operation. Failure to follow the
correct procedure may make installation impossible.

� See "4. What to Do If...."

XXX
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2. Installing and Setting Up to the Software

7 When all installation finishes, the screen shown
at right appears. Click [Close].

8 When the setup menu for installation reappears,
click .

9 Remove the CD-ROM from the CD-ROM drive.

10 Turn on the modeling machine.

11 Connect the machine to your computer using a
USB cable.
The driver is automatically registered in your computer.

Computer

USB cable

USB connector
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3. Documentation for the Programs

How to View the Online Help

The documentation for the included programs is in the form of online help. Follow the procedure below to view it.

From the [Start] menu, choose the program you're using, then click [Help].
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4. What to Do If...

What to Do If Installation Is Impossible

If installation quits partway through, or if the wizard does not appear when you make the connection with a USB cable,
take action as follows.

Windows XP/2000

1 If the [Found New Hardware Wizard] appears,
click [Finish] to close it.

2 For Windows XP

Click the [Start] menu, then right-click [My Com-
puter]. Click [Properties].

For Windows 2000

Right-click [My Computer] on the desktop. Click
[Properties].

3 Click the [Hardware] tab, then click [Device
Manager].
The [Device Manager] appears.

4 At the [View] menu, click [Show hidden devices].

5 In the list, find [Printers] or [Other device], then
double-click it.

When the model name you are using or [Un-
known device] appears below the item you se-
lected, click it to choose it.

6 Go to the [Action] menu, and click [Uninstall].

7 The screen shown at right appears.

Click [OK].

8 Close the [Device Manager] and click [OK].

9 Detach the USB cable connected to the printer.
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4. What to Do If...

10 Restart Windows.

11 Uninstall the driver.

Carry out the steps from step 3 in "Uninstall
the Driver" to uninstall the driver.

12 Install the driver again according to the proce-
dure in "2. Installing and Setting Up to the Soft-
ware."

Windows 98 SE/Me

1 Unplug the USB cables from your computer.

2 Appear the setup menu of the Roland Software
Package.

3 Select the model name you are using.

Select only the [Windows Driver] check box, and
clear all other check boxes.

4 Click [Install].
The next screen appears.

5 Select [Uninstall], then click [Start].
When driver is deleted, the next screen appears.

6 Click [Yes] to restart the computer.

7 Install the driver again according to the proce-
dure in "2. Installing and Setting Up to the Soft-
ware."

XXX
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4. What to Do If...

Uninstalling the Driver

When uninstalling the driver, perform following operation.

Windows XP/2000

1 Before you start uninstallation of the driver,
unplug the USB cables from your computer.

2 Log on to Windows as “Administrators” right.

3 Windows XP

From the [Start] menu, click [Control Panel].
Click [Printers and Other Hardware], then click
[Printers and Faxes].

Windows 2000

From the [Start] menu, click [Setting]. Then click
[Printers].

4 Click the model name’s icon you are using.

From the [File] menu, choose [Delete].

5 When the screen prompting you to confirm de-
leting appears, click [Yes].

6 From [File] menu, click [Server Properties].
The next screen appears.
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4. What to Do If...

7 Click the [Drivers] tab. Choose the model name
you are using from the list, then click [Remove].

8 When the screen prompting you to confirm de-
leting appears, click [Yes].

9 Insert the Roland Software Package CD-ROM
into the CD-ROM drive.
The setup menu appears automatically.

10 Select the model name you are using.

At the setup menu, select only the [Windows
Driver] check box, and clear all other check
boxes.

11 Click [Install].
The next screen appears.

12 Select [Uninstall], then click [Start].
When driver is deleted, the next screen appears.

13 Click [Yes] to restart the computer.

XXX
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4. What to Do If...

Windows 98 SE/Me

1 Before you start uninstallation of the driver,
unplug the USB cables from your computer.

2 Insert the Roland Software Package CD-ROM
into the CD-ROM drive.
The setup menu appears automatically.

3 Select the model name you are using.

At the setup menu, select only the [Windows
Driver] check box, and clear all other check
boxes.

4 Click [Install].
The next screen appears.

5 Select [Uninstall], then click [Start].
When driver is deleted, the next screen appears.

6 Click [Yes] to restart the computer.

XXX
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